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FAPTURBO License Agreement

All contents of the FAPTURBO web-resource and User Manual are neither an endorsement, nor
a solicitation of any sort, and cannot be considered as a promotional offering. All information
you receive is unsolicited, private encoded communications of privileged, proprietary, and
confidential information for you only and by purchasing the given product you agree to keep this
information private, confidential, and protected from any disclosure. You also agree to
indemnify and hold harmless the authors of FAPTURBO, their employees, contractors, and
service providers. Should any of the practices described herein turn out to be unlawful in any
jurisdiction, individuals pursuant to its legislation should restrain from any intentions or attempts
to apply them in any manner, either personally or in partnership with other individuals or
entities. Unauthorized copying and distribution of all or parts of this product are strictly
prohibited and will result in civil liability and criminal charges brought against the violators and
their aides.

U.S. Government Required Disclaimer - Commodity Futures Trading Commission Futures and
Options trading has large potential rewards, but also large potential risk. You must be aware of
the risks and be willing to accept them in order to invest in the futures and options markets.
Don't trade with money you can't afford to lose. This is neither a solicitation nor an offer to
Buy/Sell futures or options. No representation is being made that any account will or is likely to
achieve profits or losses similar to those discussed on this web site. The past performance of any
trading system or methodology is not necessarily indicative of future results.

Risk Disclosure: Trading foreign exchange on margin carries a high level of risk and is not
suitable for all investors. The high degree of leverage can work against you. As with all
investments, you should not invest money that you cannot afford to lose. Before deciding to
invest in foreign exchange, you must carefully consider your investment objectives, level of
experience, and risk appetite. Additionally, you must be aware of all the risks associated with
foreign exchange trading and seek advice from an independent financial advisor. Past results are
not necessarily indicative of future success. Your actual trading may result in losses as no trading
system is guaranteed. You accept full responsibilities for your actions, trades, profit or loss, and
agree to hold FAPTURBO and any authorized distributors of this information harmless in any
and all ways.

CFTC RULE 4.41 - HYPOTHETICAL OR SIMULATED PERFORMANCE RESULTS HAVE
CERTAIN LIMITATIONS. UNLIKE AN ACTUAL PERFORMANCE RECORD,
SIMULATED RESULTS DO NOT REPRESENT ACTUAL TRADING. ALSO, SINCE THE
TRADES HAVE NOT BEEN EXECUTED, THE RESULTS MAY HAVE UNDER-OR-OVER
COMPENSATED FOR THE IMPACT, IF ANY, OF CERTAIN MARKET FACTORS, SUCH
AS LACK OF LIQUIDITY. SIMULATED TRADING PROGRAMS IN GENERAL ARE
ALSO SUBJECT TO THE FACT THAT THEY ARE DESIGNED WITH THE BENEFIT OF
HINDSIGHT. NO REPRESENTATION IS BEING MADE THAT ANY ACCOUNT WILL OR
IS LIKELY TO ACHIEVE PROFIT OR LOSSES SIMILAR TO THOSE SHOWN.

Your purchase of any FAPTURBO products serves as your acknowledgement and
representation that you have read and understand these TERMS OF USE and that you
agree to be bound by such TERMS OF USE (*"Agreement’")



Introduction

FAPTURBO (FAP stands for ForexAutoPilot) was developed by a team
of professional Forex traders and programmers under the permission
of Marcus B. Leary and his team. The FAP system rapidly gained
world popularity and became the top-seling Forex product
available on the market. Nowadays, FAP has over 55,000 members.

FAPTURBO Package includes:

1. FAPTURBO EASY INSTALLER (Setup Wizard)
2. FAPTURBO USER GUIDE

3. VIDEO TUTORIALS (in Member Area)

4. VIRTUAL PRIVATE SERVER (Optional)



General Information

FAPTURBO Expert Advisor (robot) is a unique trading
robot that monitors the market situation 24 hours a day
and makes trades for you!

You should keep your Metatrader4 trading platform on
all the time, even if you are away or asleep, to let
expert advisor work properly! Trading Robot will do all
the work for you to bring you good profits!

You can also order Virtual Private Server (VPS) which
can host your trading platform securely so you can turn
off your PC while robot is trading on VPS for you.

Forex Market is open 5 days a week. No trades are
performed on weekends.

Expert Advisor (ex4 file) is not a Windows-based
program. It is a script (plugin) for Metatrader4 and can
be run only inside Metatrader4 software.

Metatrader4 is a free trading platform. You can
download it from your broker website.

Each opened trade stays in minus for some time
because you pay the spread to the broker. That is OK.
Sooner or later most of the trades will be closed in
profit.



Description of the Trading System
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FAPTURBO IS A POWERFUL COMBINATION OF 2 STRATEGIES:

e Short Term Scalping Strategy

Long Term Advanced FAP strategy

Both strategies are built inside one FAPTURBO expert advisor and can
be switched on and off easily using UseScalperStrategy parameter in

FAPTURBO settings.
Each strategy uses its own designed timeframe and currencies so be
sure you use the strategy on proper currency pair and timeframe.
Read the next part of the Guide for more details on each strategy.

Only 1 strategy can work on one Chart at the same time but you
can open several charts to run different strategies within one trading
account. More details on how to do that can be found later in this

Guide.



Short Term Scalping Strategy

Balance [ Every tick (the most precise method based on all available least timeframes to generate each tick) /90.00%

EURCHF 2007-2008

T
335 3!

54 374 394 413 433 452 472 491 511 530

FAPTURBO scalping strategy is not a traditional scalping method
where the system is trying to play within the spread making hundreds
of small trades in a minute. Such systems are very unstable and are
not allowed by most brokers.

FAPTURBO scalper is a unigue system that usually makes 1-5 trades a
day aiming for small take profit value (from 6 to 10 pips) when the
market is stable enough (often during nighttime in Europe).

FAPTURBO SCALPER STRATEGY

1999-2008 EURGBP

By default scalper strategy does not make any trades during day
time (GMT) and does not trade on Fridays, where the market is too
unpredictable. (and of course no trades on weekends)

Scalper strategy is very safe because it has a low value stop loss limit
and advanced algorithm that closes the trades according to inner
indicators.

Stealth Mode protects you from cheating on the broker side. Using
the stealth mode the take profit and stop loss values are not
displayed to broker.

Scalper strategy works on EURGPB, EURCHF, GBPCHF or USDCAD
currency pairs on M15 timeframe only.



GMT OFFSET is a very important parameter for scalper strategy. It
defines the offset in hours between GMT and your broker time
(market watch in MT4). It should be set carefully in order to let
Fapturbo work properly. You wil find more details on each
parameter later in this Guide!

Spread of your broker is another vital setting for scalper strategy. Do
not use scalper strategy on brokers with spread = 5 or more. For
scalper strategy allowed spread size is 2-4 only.

Spread is the difference between Bid and Ask Price for the currency
pair. If price is 0.8147 / 0.8150 that means Spread = 3

If scalper strategy does not open any trades for a week (and you
are sure you set all parameters correctly) it means that your broker
spread is unacceptably high. In this case you should change to
“Fapturbo Long Term Strategy” or find other broker.

Now lets analyze the scalper strategy and find out the weak and
strong points.

The weak points are:

e Scalper strategy has very small take profit from 6 to 15 pips so it
is very sensible to the spread size. If you broker gives you an
unusually big spread (for example spread 5-6 for EurGbp or
more instead of normal 2-4) then scalper strategy will have a
hard time trading it. It will miss a lot of trade or will not trade at
all. Check your broker for the spread size!

e Scalper strategy does not work well on crazy market conditions.
When the currency pair has an unusually strong trend or very
high volatility (It is recommended to avoid trading on such
days. We tried our best to filter out such days automatically but
still do not recommend trading on high volatility days.)



Strong points:

e Very safe. Scalper strategy has an inner fixed stop loss and
sniper-accurate trading signals so the risk is very low and the
drawdowns are extremely low.

o Extremely profitable. Despite the fact the take profit value is
rather small, Scalper strategy is extremely profitable. You can
literally double your deposit in a matter of weeks even trading
safe lots.

So | guess your question is:
What parameters in scalper strategy should | change if | am
new to forex?

The answer is simple. You should set fixed lot size or autolot and
check the GMT_offset parameter. Other settings can be left as
defaults! Read more about GMT offset later in the guide.



Long Term Advanced FAP Strategy

alance [ Equity f Every tick (the most precise method based on all available least timeframes to generate each tick) / 25.00%

FAPTURBO ADVANCED FAP STRATEGY
FIXED LOT SIZE =1

DEFAULT SETTINGS

2005-2008.11 EURUSD M1

0
85 401 418 434 451 468 484 501 518 53 55 56 34 601 617

FAPTURBO uses advanced FAPS (ForexAutoPilot) Algorithm.

The Trading system of the ForexAutoPilot expert advisor is based on
several modern Forex indicators such as Alligator, Fractals, DeMarker,
and Wiliam's Percent Rate. The system detects a good trend and
confirms it using internal indicators, then opens the trades to make
maximum profit for you. ForexAutoPilot advisor monitors each open
trade carefully and closes it if it reaches the takeprofit limit when the
trade is successful.

FAPTURBO developers have added a great number of new features
to FAP Algorithm to make it:

e More Safe. Now FAPTURBO FAP strategy uses fixed stop loss
value so your possible losses will be small and limited. A great
number of additional safe filters and indicators were added to
prevent trading in risky conditions.

e More Profitable. Advanced filters and indicators that were
added to the system make sure FAP avoids risky periods with
unstable market and makes most of the profitable trades with
high accuracy.

FAPTURBO Longterm FAP STRATEGY was optimized for the Dbest
performance on EURUSD pair M1 (1 minute timeframe).

Note: To enable long term strategy the UseScalperStrategy
parameter must be in FALSE position.

FAPTURBO Long Term Strategy is optimized to avoid trading during
risky market conditions. No trades will be opened on such dangerous



days. Please have patience! If it does not open any trades for a
week or two that means the market is in a risky zone!

So here are the weak and strong points of long-term strategy.

Weak points are:

« It does not trade very often; so don’t expect too many trades
every day. FAPTURBO Long Term Strategy is optimized to avoid
trading during risky market conditions. No trades will be
opened on such dangerous days. Please have patience! If it
does not open any trades for a week or two that means the
market is in a risky zone!

« Trades can stay in the drawdown for sometime until they reach
a profit. Expect to have a drawdown for a day or even week
until a trade finally reaches the profit target. That is normal and
part of the successful system. Don’t worry too much here, the
drawdown is limited by the fixed stop loss value

Strong points are:

« Fapturbo Long term strategy does not care about the spread size
and the volatility of the market. It has a rather large value for take
profit.

« Fapturbo Long term strategy is a very complicated system and
can adapt to nearly all market conditions. It behaved well and
made good profit even in crazy situations with EUROUSD during
the end of 2008. It can survive nearly all hardships and will bring
you profit in the end.

Trading the long-term strategy you should take into account that
your goal is to make a profit long term. You should check your results
monthly or quarterly, not every day or every week. The idea here is
to make you a profit in the long run! So have patience and you wiill
be amazed by how well it works!



What Is Expert Advisor?

Q: What is Expert advisor (EA)?

A: Why do 90% of Forex traders lose? Traders are humans, and, like all
humans, we suffer from greed. Like all humans, in crucial moments
(or market conditions), we lack confidence, we have fear of what
might happen, and most importantly, we are usually (90% of the
time) inconsistent. Taking this into consideration, 90% of traders WILL
LOSE MONEY IN FOREX. They will consistently give away their money
to the other 10%.

This, together with the illusion of becoming millionaires overnight
trading with some "guru's" trading system from an ebook, is what
keeps the Forex market a great business for Forex brokers and the so-
called “gurus”. If you really understand this, then you can actually
MAKE MONEY IN FOREX! How? The easiest way to do it is using a
profitable expert advisor.

Expert Advisor is an automated robotic script written in MQ4
language that can work in the Metatrader4 platform and make
trades for you!



An Expert Advisor is a "robot". Robots beat humans at chess, and
they beat humans at trading. An EA robot will watch the market for
you, placing trades under certain parameters (strategies), avoiding
the fear, greed, lack of confidence and inconsistency which
characterizes most traders.

The Expert Advisor has a plan. It sticks to it no matter what, no matter
how ugly or uncertain the market looks. It has no greed and will be
running 24 hours a day for you.

Expert Advisors can only work when the connection to the Internet
(in Metatrader4) is established. You must always keep your
Metatrader4 online and working to let the advisors trade. If you close
Metatrader4, advisors can’t monitor the trades and that could
cause you possible losses of deposit. Again, Forex Market is open 5
days a week. No trades on weekends.

Q: What if my PC lost power or rebooted?

A: No problem here! Just run Metatrader again and turn on the
expert advisor. It will continue trading. If you have continuous power
losses and poor internet connection or simply cant keep your PC
online all the time we suggest that you order VPS (Virtual Private
Server) for hosting your trading.

Q: How do | remove expert advisor?

A: To remove an advisor, just right click on its name or face in the top
right part of the chart and select «Expert Advisors -> Remove». Don't
forget to close all open trades of the current advisor if you remove it.
Q: Important: Demo or Real account?

A: You should always test your advisor on Demo account first to

check if your broker is compatible with your current expert advisor!
NEVER trade on Real account without testing on Demo first!!



Maybe your broker takes your orders too slowly, gives bad quotes or
has too high a spread or slippage. If so, we recommend you try the
Demo account with another broker

Q: How do | run several advisors on one account?

A: That is very easy! You can run several advisors at the same time to
increase your profits and minimize risks! Open several Price Charts
and attach each advisor to its own chart! This way, they can all work
at the same time. Don't try to attach 2 advisors to the same chart.
That won't work!

Warning: Don't run too many advisors if your deposit is too small. Try
on DEMO account first to see how they work together! Some of the
advisors are incompatible with each other and work poorly if you run
them together. Please always try on Demo first if you want to run
several advisors at the same time! If you get bad results — don't run
those advisors together or simply change your broker.

Q: What timeframe and currency should | choose?

A: Most of the robots work only on specific timeframes and
currencies. For example, FAPTURBO advanced FAP strategy works
best on EURUSD pair on M1 timeframe. FAPTURBO short term
scalping strategy works on EURGPB, EURCHF, GBPCHF or USDCAD
currency pairs on M15 timeframe only. The best performance is on
EURGBP.

Q: Which advisor and strategy is the best one?

A: There is no clear answer to this question. Every advisor uses its own
unique system of trading, and each has its own strong and weak
points. We recommend running several advisors at the same time
and testing them on Demo to find out which advisor works best for
you!

Q: How do | make a backtest on history?



A: To perform a backtest calculation, you should open Metatrader4,
go to main menu View -> Strategy Tester (CTR+R) or press F6 (if the
EA is attached to the chart already). Then you should set the
parameters, currency, timeframe and time period and then hit

“start”. Don’t forget to download the historical data first from the
HISTORY CENTER (F2).



Getting started

We provide step-by-step instructions on how to start trading with
FAPTURBO. Just follow the easy steps below:

1. Download and install the Metatrader4 (MT4) platform.
You can choose any broker that supports Metatrader4. We
recommend ForexMeta broker (FXDD) with Metatrader4

http://www.forexmeta.com/forex (includes a $500 USD
signup bonus)

2. Download and install FAPTURBO using Easy Installer (Setup
Wizard)
Read the corresponding chapters of this Guide for more
information

3. Attach expert advisor to the chart, activate it and let it trade
for you!
FAPTURBO will analyze the market and trade for you 24/5, even
when you are asleep or away! Just keep your Metatrader
platform on.

Watch the Video Tutorials!

éé Please open your member area on the FAPTURBO.com
website and watch the video tutorials!


http://www.forexmeta.com/forex

Step 1: Download and install the Metatrader4
(MT4) platform

You can choose any broker that supports Metatrader4 platform
such as Alpari, InterbankFX, FXDD, ForexMeta etc. Feel free to use
your existing brokerage account or choose one by yourself.
However we strongly encourage the ForexMeta Brokerage. Since
FAPTURBO has become such a widely acclaimed success we
where able to negotiate a custom deal with ForexMeta. Those
guys know about the Fapturbo software and offer EXCLUSIVELY for
our clients a 500 USD bonus on your deposit*.

roreXiviedd

FOReEH TrRADING SIMPLIFIED

ForexMeta broker (FXDD) with Metatrader4:

74 http://www.forexmeta.com/forex (includes a $500 USD
signup bonus?*)

$500 Bonus Opportunity

Real-Time Executable Quotes

24 Hour Customer Support
Competitive Spreads

Ability To Open Any Account Type
Extremely Reliable Platform
Automated Trading Capability

Free Platform

Fast And Easy Execution

Advanced Charting with Numerous
Indicators and Line Studies

e Capability To Trade From Your Charts
e Autostrategy Feature So You Can Program
Your Own Strategies

* The $500 bonus credit to the account is subject to the client completing at least 40 full
lot closed trades within the first 60 days of the account approval. Bonus is provided only
by ForexMeta broker, not by FAPTURBO developers. Other brokers do not provide this
signup bonus.


http://www.forexmeta.com/forex

Step 2: Download and install FAPTURBO
Expert Advisor using EASY INSTALLER

Perform this step only when you have successfully installed
Metatrader4 on your computer. Download the FAPTURBO Easy
Installer (FapTurboSetup.exe file) from your members Area on the
FAPTURBO.com website and run it.

'/ g
I -"'! ]

e Xp
SERES00AC Windows
COMPATIBLE
WITH VISTA!

FAPTURBO Installer works on Windows 2000/ XP / Vista.

.} FAPTURBO Setup Wizard e | @ (]

A N Welcome to FAPTURBO
1 W Setup Wizard

This installer will help you setup FAPTURBO
expert advisor to your Metatrader4 platform!

Press "Next" to continue installation.

Follow the steps in FAPTURBO Installer (Setup Wizard). It will guide you
through the setup process.



On the main stage of the installation process the Setup Wizard will
ask you to specify the Metatrader4 software root folder. It is the
exact folder where you installed your Metatrader4 Platform
previously.

The path depends on the broker you use. It is often found in Program
Files on Disk C:

C:\ProgramFiles\MetaTrader - ForexMeta
C:\ProgramFiles\Alpari Metatrader
C:\ProgramFiles\ FXDD - MetaTrader 4
C:\ProgramFiles\ FXCM - MetaTrader 4
C:\ProgramFiles\ Interbank FX - MetaTrader 4

Or something like that. It should be the root folder of Metatrader!

' FAPTURBO Setup Wizard

Locate Metatraderd software root folder.

Please specify your Metatrader4 software root foldd
Browse folders
C:\Program wTrader.Meta

Itis often located at elect Metatraders software root folder
C:\Program Files\Metatrader4 or

C\Program Files\ForexTrader.Meta or

C\Program Files\nterbank FX Trader 4 C:\Program Files\ForexTrader.Meta

The path could vary depending on which broker yo

If you do not have Metatraderd installed please clo Fake Voice

this setup wizard again! FapTurbo
If you are sure you have installed Metatrader befor i
him about the Metatrader4 path. L

Fa: ractive
Metatrader 4 iz a free tre

instructions for more infi

config
deleted

experts

Cancel




Known Questions and Problems:

Don’t have Metatrader4?

You can get free a Metatrader4 platform on the ForexMeta broker website. We
recommend ForexMeta broker (FXDD) with MT4
http://www.forexmeta.com/forex/ (featuring a $500 USD signup bonus)

Easy Installer (Setup Wizard) does not work for me!

In this case you can install manually. Just download the fapturbo files from the
FAPTURBO ZIP Package (can be found in member area download section) and then
place Fapturbo.ex4 to the /experts folder and fapturbo.DLL to the libraries folder in your
Metatrader folder.

| have MAC OS. Can it work on MAC?

Metatrader4 was created for Windows only but there are 2 ways you can still use
it on MAC OS. The first way is to setup Metatrader on Mac OS following this short
manual. The second way is to order VPS Service that can work with MAC OS
without any problem.

| Don’t have WinZip.

You can download the free WinZip Evaluation Version
http://www.winzip.com/downwz.htm to extract the Zip archive or just use the
free WindowsXP/Vista zip service. You can also use the free WIinRAR to unzip files:
http://www.rarlab.com/

Watch the Video Tutorials!

éé Please open your member area on the FAPTURBO.com
website and watch the video tutorials!


http://www.forexmeta.com/forex/
http://www.winzip.com/downwz.htm
http://www.rarlab.com/

Step 3: Open your Metatrader software

Run the Metatrader4 platform and open your Demo or Real
account. If you are a newbie, we recommend that you trade on
Demo until you feel confident with the system. You will see the list of
expert advisors under the Navigator Panel on the left of the screen.
FAPTURBO will be among them:

File Miew Insett Chars Tools Window Help

1 | Bl veworder B |6 Expert advisors
=

Market Watch: 16:5%:59 x

[ EURCHF M15

& AUDNID 2 L 7380 147420 GBPCHF.MI5 1.85160 1.86450 1.86050 1.86210

Symb 1 -

B ALDIR

& CHFIPY
& EURALID
% EURCAD
4 EURCHF
4 EURGEP
& EURIFY

Mavigator

Common

Symbol

Known Questions and Problems:

Why are some expert advisors shown in grey?

Experts-Robots are shown in grey because they don’t have open source codes.
That’s fine. It is not a problem at all. They wiill still work fine if they have the Smiling
Face on the top right of the attached graph. Template MT4 experts like “MACD
Sample” and “Moving Average” are free samples with open source and that’s
why they are shown in yellow.

| installed Fapturbo to my Metatrader using installer, but | do not see
FAPTURBO on the "Navigator" panel.



The problem could be that you have several Metatraders installed on your PC.
Check if you installed the fapturbo to the correct folder of the correct MT4 copy.

Watch the Video Tutorials!

éé Please open your member area on the FAPTURBO.com
website and watch the video tutorials!



Step 4: Attach FAPTURBO EA to the chart

First of all you should set the correct global settings in your
Metatrader4 platform.

Click Tools in main menu - > Options - > Expert Advisors Tab

Make sure you have the same settings as shown on the screenshot
below. Enable Expert Advisors checkbox must be checked. Allow
Live Trading must be checked. Allow DLL imports must be checked
too. Confirm DLL Function calls must be unchecked.

Options

Server | Chars | Objects | Trade | Expert Advisors | Email | Publisher | Events

| Disable experts when the profile has been changed
J | Allow live trading
Ask manual confirmation
J | Allow DLL imports
Confirm DLL function calls

J | Allow external experts imports

Then click OK to close the window.

Make sure the «Expert Advisors» button on the top of Metatrader4 is
in “pushed” position:

_I_-_-, Expett Advisors

Choose the currency pair you want to trade and open its chart
window with price candles. To do that simply right click on the
currency title in the top left panel with currency rates and choose
“Chart Window” command.

4+ EURCHF

5

¥ EURJPY
¥ EURUSD

MNew Order




For example, you want to run FAPTURBO Scalper for EURGPB M15
Chart. Then drag and drop the advisor from the «Navigator» menu to
the chart window.

Mavigator

The “Settings” Window will appeatr. It is described on the next step.

Known Questions and Problems:

What TimeFrame and Currency should | choose?
Scalper strategy works on EURGPB, EURCHF, GBPCHF or USDCAD currency pairs
on M15 timeframe only.

FAPTURBO Longterm FAP STRATEGY was optimized for the best performance on
EURUSD pair M1 (1 minute timeframe).

Note : To enable long term strategy the UseScalperStrategy parameter must be
in FALSE position.

My Metatrader4 crashes when | run the FAPTURBO EA!

That means you did not update the MT4 version to the latest build. Please
update it!



Step 5: Check Settings

After attaching the FAPTURBO adyvisor to the chart, you will get the
Window with Advisor's Parameters. You need to set the Common Tab
parameters: «.ong and Short positions» and enable the checkbox
«Allow live trading» to let advisor trade Forex for you! Also check
«Allow DLL imports» and «Allow import of external experts» and
deselect «Confirm DLL function calls».

FAPTURBO
Common | Inputs

Common Safety

Long & Short - | positions | Allow DLL imports

¥ Enable slerts Confirm DLL function calls

Disable alert once hit o | Allow import of external experts
Live Trading
J | Allow live trading

Ask manual confirmation

You can also check and edit The Stop Loss, Take Profit and other
parameters in «iInputs» menu. You can also load and save presets
there. All parameters are described in this GUIDE later in the special
section.

Note: To enable long-term strategy the UseScalperStrategy
parameter must be in FALSE position.



[ FAPTURBO

Common | Inputs
Value
— Scalper EURCHF, EURGPB, GEPCHF or USDCAD M1...

0.1

15
100
;

If the UseScalperStrategy parameter is set to TRUE then Fapturbo wiill
trade on scalper strategy on this chaurt.

Note: Some brokers have 5 digit price quotes (for example 1.12340).
Fapturbo will adapt to them automatically! No need to change any
settings.

Then click "OK" to run the advisor! If you set the advisor correctly to
the proper timeframe and currency, you will see its smiling face in
the top right corner of the Chart window. That means the advisor is
working and monitoring the market now.

[ EURGBP,M15

IDOC2008 3001230 3002030 31 Oct 0430 Jl.OctlZJD

Note: Most of the advisors don't open the new orders instantly after
you run them! Be patient! Advisor is monitoring the market and
opens its trades only on condition of possible profits!



FAPTURBO will open trades a few times a week when its internal
indicators find the proper market conditions to open trades.
FAPTURBO doesn’t have to open many trades or trade every single
day! The goal is to make a profit, not to make many trades!

Usually Fapturbo opens 2-15 trades a week depending on the
strategy you’ve chosen. If you followed the steps correctly but
FAPTURBO did not open any single trade for the last 10 days then
you should contact our friendly support team for help and
assistance.

Forex Market is closed on Saturdays and Sundays. No trades will be
performed during the weekend. There is no need to turn off advisor
during weekend. It will sleep and continue the trades as soon as the
market is opened again.

Note: Please note that all new open trades stay in minus for some
time because you have to pay the "spread" (commission) to the
broker! That is not a problem. Sooner or later most of the trades will
close in profit. Have patience.

Known Questions and Problems:
When | drag the expert advisor onto a chart, | don't get the smiley

face, just an X. | follow the procedure but it still doesn't respond.
The Smiling Face icon means that EA works correctly. If you don’t see the Smiling
Face, just click on the “Expert Advisors” button on top of the Metatrader menu.

| see the sad face ® of the expert advisor instead of smiley face ©

If you see the Sad Face that means you forgot to set the “Allow live trading”
parameter for the expert advisor. Please check the parameters.

How do | change the parameters after | attached the EA to the
chart?

Right click on the smiling face and select “Expert Advisors - > Properties” or press
F7.



Step 5: Activate your copy

Now it's time to activate your copy of FAPTURBO EA. Just a few
minutes after attaching FAPTURBO EA you will get the following alert:

r

8 Alert HESD

YOLF EAFS o2y 15 nat aZtivyated, Hease activate it n ForexAuoPiot, o Membst areal Your Expert ID=800Y 00945

Your FAPS Copy s ol cilivaled, Plecse aclivale Lo ForesScLoRilol oo Meniler Area! Yoor E,

uur FaPs . dled, Please aclivale il 1 ForesAcLoRiloloon Menber Areal Yoor E.

Your F&FS Copy s ol e livaled, Please aclivale il o ForesfcLoRluloo  Meniler Areal Your E. ..

Your FaP3 Cuovy s b cilivaled, Please aclivale il o Fores@ LoBloloon Menler Areal Yoor E.

o

Note: If you don’t get this alert right away that could mean one of
several things:

e Today is a non-trading day (weekend or Friday, for example). Wait 2-3
days for this alert to appear.

e You forgot to set correct parameters, for example “Allow DLL imports” in
EA settings. Check previous steps carefully.

Record your Expert ID. For example my expert ID is 808923445

Then open your FAPTURBO Member Area on the website
FAPTURBO.com and insert your expert ID to get your «Activation
Key». On the website member area at “Step FOUR” you will find a
field to input your ID:



b= Step Four

Fap Turbo Anti Piracy Protection

In order to prevent depreciation of our (and your) software we put a
stable anti piracy mechanism in place that prevents software piracy.

Insert your FAPTurbo expert ID: 308923445 Get My Activation Key

Should you Ei‘i::__: o ﬁw issues with this step , please watch the video
tutorial below. ™ /"

VideoTutorial: How to activate Fab Turbo

Press “Get My Activation Key” button. You will get a key:

/OUR Activation KEY=045614050

Record the Activation Key. For example my Key 045614050

Now open Metatrader4 with FAPTURBO attached to the chart and
right click on the FAPTURBO Smiling Face on the top right side of the
chart and select «Expert Advisors -> Properties» or just press F7.
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Click on the «Inputs» tab and scroll down to the «KEY» parameter
and fill in your Activation Key from the website!

[ FapTURBD.

Inputs

That's all! Your copy is activated and ready to use!

Known Questions and Problems:

e Where is the Member Area? | lost my link.
You got the link to the member area access details with your
welcome email after purchase. Here is the link to Login:
http://fapturbo.com/login.php Try to find it there or contact our
support team with the batch/receipt number of your payment.



http://fapturbo.com/login.php

You can also try “Forgotten Password” to retrieve the lost
password to your email.

e My expert ID=0!! Help me!!
This is a common but easy to fix glitch in Metatrader4. First
check the EA settings. Turn on "Allow DLL imports" and remove
"Confirm DLL function calls" there. Also check the global
parameters of the Metatrader: Tools -> Options -> Expert
Advisors. Turn on "Allow DIl imports" and turn off "Confirm DLL
function calls". I'You must Just restart
your Metatrader and try again! It helps. If it happens again in
the future then just restart your metatrader.

e | don’t see the Alarm Window with Expert ID!
Maybe your copy is already activated or you forgot to check
"allow DLL imports" and remove "Confirm DLL function calls" in
the EA settings. Another possible reason: Today is non-trading
day (weekend or Friday, for example). Wait 2-3 days for this
alert to appear. It will appear only during trading days.

e My Metatrader crashes when | try to attach EA to the chart.
That means you use outdated MT4. Please update it to the
latest build.

e My FAPTURBO License has expired. What do | do?
We update FAPTURBO every month to make sure it is always up
to date to the modern market conditions. You should
download the fresh version of fapturbo from the member area
every month and install it instead of the old version. Each
version is licensed for 1 month only. All updates are FREE to our
members.

Watch the Video Tutorials!

éé Please open your member area on the FAPTURBO.com
website and watch the video tutorials!



FAP-WINNER.com Service Overview

FAP-WINNER.com is a special service for ForexAutoPilot & FAPTURBO clients with
premium support (rapid support, Live Chat, Appointment Calendar, Forum,
Phone support) and advanced trading opportunities (Special FAP settings,
Personal Trading Plan, Hedging EA) as well as weekly Mentoring and Coaching
Class and Seminars/Webinars.

FAP-Winner was founded by Charles A. Floyd I, professional forex trader with 20
years of experience.

FAP-Winner is not a part of FAPTURBO or FAP service, it is a separate product
created by Charles A. Floyd, II.

FAPWINNER FEATURES & BENEFITS:
1. FOREX AUTOPILOT TRADING SYSTEM (FAPTS & FAPTS-TURBO)

e FOREX AUTOPILOT
One of the best Expert Advisors available on the market. It's effectiveness
has been proven in numerous tests and live trading by over 25,000
members in the last 12 months

e FAPTS Settings
Unique Forex AutoPilot modifications and settings developed and
optimized by Charles A Floyd, Il.

e FAPTS Trading Plan
Solid money management plan "March to Million", developed personally
by Charles A Floyd, Il to work for any account size

e Hedging / Grid Trader EA
One of the best hedging EAs available online. Developed personally by
Charles A Floyd, II, professional trader with over twenty (20) years of
experience.

2. FAPTS HAS BEEN PROVEN EFFECTIVE

e Solid Backtesting Results
Defined Buy/Sell Area

e Tripled Deposit of Live Account
Want proof? FAP tripled one live trading account! Check out the full and
consistent trading statement on the website.



Effective On All Types of Trends
FAP works perfectly on downtrends, uptrends and sideways trending
markets!

Never Lost Deposit On Backtest
You can backtest FAP for many years and verify that is has never zeroed
the equity in a single account!

Adjustable Settings
You are able to perform your own optimizations to find the absolute best
settings for you!

Works 24/5 On Autopilot

Simply drop and trade! Just attach the FAP EA to a chart, and let FAP
work its magic trading in the forex market 24 (twenty-four) hours a day, 5
(five) days a week for you!

No Forex Skills Required
With our detailed instructions and friendly, personalized support, you won't
have any problems with the setup, even if you have never traded before!

3. FAPWINNER MEMBERS AREA

Personal Members Area
Every member of FAPWINNER is provided access to the secure member
area on the website.

Downloads Section

In the downloads section, every member can access the FAPTs system
files, documentation, sound and video archives from the mentoring
classes and chat meetings

FAPWINNER Newsletter

Here our members can read the hot news about current and future
FAPWINNER projects, learn about upcoming events in the FAPWINNER
community, as well as schedules for the video and chat meetings

Support Section
Here our members can get full, personal help from knowledgeable,
award winning FAPWINNER support staff, hand picked by Charles.

4. FAPWINNER DISCUSSION FORUM

You Are Not Alone!

All FAPWINNER members have access to the private discussion forum
where all your questions can be answered. You can discuss anything
related to FAP including setup, effective strategies, usage and settings.



Moderators and Administrators
All staff are friendly, polite, responsive and always ready to address your
needs!

5. FAPWINNER VIDEO CHAT MEETINGS

Join The Live Chat With Other Traders!

All FAPWINNER members have access to the daily and weekly online chat
meetings. Charles has been famous for his friendly FAPUG meetings held
every Sunday and Thursday!

Video Chat and Webinars
Charles presents his own personal video sessions and mentoring classes as
well as Forex webinars!

Recorded Sessions
Can't attend the meeting? No problem! Get access to the download
page with recorded sound and video sessions archives!

Lots of Traders talking online
You'll be excited by the activity in the chat sessions! Traders from all over
the world are always here to share ideas and discuss the forex market!

6. AWARD WINNING SUPPORT

Live Chat Support

All Gold FAPWINNER members are provided with 24/7 live chat support.
Friendly, professional support staff is are always ready available to help
you online!

Fast Reponse

No more hassles and waiting, no more unanswered emails and phone
calls. Charles's professional support team has proven itself to be one of
the best on the Internet!

Tons Of Support Options

You will be amazed by the variety of support options we offer at
FAPWINNER. These include fast email support, live chat, Skype, instant
messaging, 1 to 1 mentoring, remote access support, personal
appointment scheduling calendar, traders' forum, private messaging and
much, much more!!

Appointment Calendar
Every supreme FAPWINNER member can make a personal appointment
with Charles for 1 to 1 mentoring

Remote Access Help
We can help you with your FAP setup, using our remote access software!
No more problems with the setup even if you are a computer newbie!



Mentoring And Coaching Classes!

Not a Forex pro? No problem! Enroll and attend our friendly mentoring
classes, webinars, or read tons of available literature and instructions! We
are always here to teach and help you to get started right away!

7. JOIN THE FRIENDLY TEAM

FAPWINNER Lifestyle
The FAPWINNER Group is more than just a gathering of moneymakers, we
are a family.

FAPWINNER Group Is Growing Rapidly

We have over 17,000 members and are growing every day! Our members
include all kinds of people just like you, from total newbies to forex pros
with years of experience. FAPWINNER is a place to make friends and
develop relationships!

Be A Winner With FAPwinner

So what are you waiting for? FAPWINNER is exactly what you need, to get
where you want to be. Join us right now and become a valued member
of the FAPWINNER friendly community

Join FAP-Winner.com now!

" http://fapwinner.com/



http://fapwinner.com/

VPS Service overview

Article by Uriel Katz

Forex Robots need to be trading 24 hours a day, 5 days a week, using your
computer resources. Interruptions in the work of the robots may result in missed
trading opportunities or money lost. Sometimes, you may also be unable to
restart your computer or make any action which may affect the trading
platforms and therefore the robot's work. For example maintenance of your
computer or new installations may have to be left for the non-trading days. This
may be a little bit annoying sometimes.

You may also be afraid that other people will use your computer (like in
example your kids). You may fear that they might accidentally close the
platform of worse even, make a manual trade that will cause you losses. And
what about a power shortage? What about the system being accidentally
restarted? No limit to our worries.

Kids & Family

Monitored & |
Supervised

Preinstalled
Metatraderd

{Online

Is there any solution?

YES, it is called a Virtual Private Server (VPS). VPSs are computers based in large
companies providing access to these computers for a monthly fee, through the
Internet. These computers are maintained by experts, have strong and updated
security hardware and software like firewalls and virus protection. They are
working most of the week apart from hours of scheduled maintenance (and of
course unscheduled, should any problem arise). You may access and operate



these computers through any computer, by remote control (what is called
terminal-operation).

You just need access to the Internet, login using your username and password,
and you operate your VPS. Now you may leave the VPS working, say with
MetaTrader platform and a robot and close your connection with the VPS.
Therefore you may use your home computer as needed for anything, without
worrying about your robot working in the VPS. Even when you turn off your
computer it is working. These companies have generally power-backup so they
won't be affected by power shortages.

. tetatrader and B4 hosting

Forex Hoster is a perfect solution for hosting your trading.

The Virtual Server setup of FX Hoster has been tailored specifically for
the FapTurbo robot. It’s a breeze to get going and features:

e Easy uploading Panel for uploading the FapTurbo robot.

¢ Preinstalled Metatrader4 platform with a brokerage of your
choice

¢ NoO hassles with server setup and configurations

e No server knowledge needed!

e Works for MAC and Windows!

Order VPS Right Now!

&) http://forexhoster.com/



http://forexhoster.com/

Correct Lot Size & Risk

To put it into easy terms, the lot size will define the risk of each trade.

If you set too large a lot size for a small deposit, even a small
drawdown will kill your deposit! So please be careful setting lot size.

If you attach EA to 2 charts with same lot size that means you
DOUBLE your risk (and possible gains). Be careful and consider the
risk!

If you are not sure how to set correct lot size manually we
recommend you use AUTOLOT (Money management) parameter. To
activate it set Scalper UseMM = true (for scalper strategy) or
FapTurbo_Lots = 0 for Long Term strategy.

It wil define the Ilot size for you automatically based on
“LotRiskReductor” value. For example if you set LotRiskReductor = 5
then it will risk 5% of your available margin to open new position and
will calculate the lot size properly.

Example for Standard Accounts:

e If you are using a small deposit under $2,000 USD, then set Lots
=0.1

e [f your depositis $ 5,000 then you can set Lots = 0.5
e If you have alarge deposit over $10K, then set Lots = 1 or more

Be aware of risk on Forex and trade only money you afford to loose.
Always start on Demo first if you don’t feel confident with the
strategy!

Watch the Video Tutorials!

éé Please open your member area on the FAPTURBO.com
website and watch the video tutorials!



FAPTURBO PARAMETERS

SHORT TERM SCALPER STRATEGY SETTINGS

Scalper strategy works on EURGPB, EURCHF, GBPCHF or USDCAD
currency pairs on M15 timeframe only. Best results are on EURGPB
pair.

To activate Scalper Strategy you should set UseScalperStrategy =
TRUE parameter FAPTURBO settings.

e Scalper_Lots - fixed lot size if Money Management is off
(Scalper_UseMM = false)

e Scalper_UseMM - turn on/off the money management (auto
lot calculation)

e Scalper_LotsRiskReductor - Percent of free margin used to
open new order. Can be from 1 to 100. Itis used only if
Scalper_UseMM = true

e Scalper MaxLots - Maximum Lot size

e Scalper GMTOffset - Broker Time offset from GMT Time. (In
Hours)

GMT OFFSET is a very important parameter for scalper strategy. It
defines the offset in hours between GMT and your broker time
(market watch in MT4). It should be set carefully in order to let
Fapturbo work properly. If you fail to set the GMT offset carefully you
can get unexpected losses. Please be careful! Ask your broker about
their GMT Offset if you are not sure!

Please note: If your Market Watch is that means that your
broker is on the weekend holiday and that broker time is not valid for
GMT offset. You should wait until your broker is on the trading day to
set the proper GMT offset value!

Also please mind the switch from summer to wintertime twice a year.
Some brokers switch the time so you should adjust your GMT offset
again on these days!



Example:

If Greenwich Mean Time is 23:33 now and the market watch shows
you 0:37 that means your GMT offset is 1.

Don't forget to check if your broker switches to summer or winter
times! That can influence on the GMT offset value!

Set proper GMT offset every time you attach the EA to the chart!

wwp.greenwichmeantime.com

#% 1107403: MetaTrader - Alpari - Demo Account GREENWICH MEAI:I;I—IME (GMT)

File VWiew Inset Chars Tools Window Help Greenwich Mean Time (GMT)
e — e M Wednesday, 5 November 2008
- B - ]| Gt One B I Dpent Ao Bl 23:37:17111:37:17 pm
LR B '
Market Watch:

_ -. Example:

+ USDCHF B 1502 : = EURCHF,M15 1.4995 1

4 GEPCHF

& EU F!"tlm ol GMT: 23 :37

Market Watch 00:37
GMT OFFSET =1

e Scalper_StealthMode - turns on / off Stealth Mode. The
Stealth Mode protects you from cheating on the broker side.
When using the stealth mode the real take profit and stop loss
values are not displayed to your broker. (EA opens “fake”
values for S/L and T/P)

e Scalper_UseCustomLevels - Turns on and off the
CustomLevels filter

e Scalper_RelaxHours - the number of hours to miss after
hitting stop loss

e Scalper_SimpleHeightFilter - turns on/ off the simple bar
height volatility filter

e Scalper_TrendFilter - turns on / off Trend Filter based on
the Moving Average calculation

e Scalper_TradeFriday - if true then trades on Fridays



e Scalper_OneTrade - if 1 then opens only 1 trader per day

e Scalper_UseFilterMA - turn on and off the MA global filter.

e Scalper_PeriodFilterMA - period of filtering MA

e Scalper_PriceFilterMA - PriceMA 0 6 - the way of
calculating MA. 0=PRICE_CLOSE, 1=PRICE_OPEN,
2=PRICE_HIGH, 3=PRICE_LOW, 4=PRICE_MEDIAN,
5=PRICE_TYPICAL, 6=PRICE_WEIGHTED

e Scalper_MethodFilterMA - — the type of MA. 0=Simple,
1=Exponential, 2=Smoothed, 3=Weighted

e Scalper_ExpertComment - "FapTurboScalper": Comments
for log

Question: What parameters in scalper strategy should | change if |
am new to forex?

You should set fixed lot size or autolot and check the GMT offset
parameter. Other settings can be left as defaults!



LONG TERM ADVANCED FAP STRATEGY SETTINGS
Advanced FAP strategy works on EURUSD pair, M1 timeframe only.

To activate Advanced FAP strategy you should set
UseScalperStrategy = FALSE parameter FAPTURBO settings.

Advanced FAP strategy has a lot of parameters that can be
adjusted only by FAP expert traders. If you are a newbie then just use
the defaults. We’ve already put in a lot of time and hard work
optimizing these parameters for the best performance for you! Only
set the proper lot size for your deposit or use autolot.

e FapTurbo Lots - sets the fixed lot size. If Lots = 0 then AutoLot
is activated. (Money management is on)

e FapTurbo_LotsRiskReductor - the percent of free margin used
to open new position. It is used only if FapTurbo_Lots = 0.
LotsRiskReductor defines the risk. To let the program use AutolLot
management (it means that EA decides the lot size itself), the
variable Lots should be set to zero. LotsRiskReductor will then
define the risk size. LotsRiskReductor can be from 1 to 100. 1
means 1% risk of deposit, while 100 means 100% risk.

e FapTurbo MaxOrders - Maximum number of opened orders at
the same time

e FapTurbo MaxLots - Maximum Lot size

e FapTurbo_StopTime - Time delay between first and
second opened order (if Maxorders=2 or more)

e FapTurbo aaa - parameter for DeMarker indicator

e FapTurbo bbb - parameter for WPR Indicator

e FapTurbo_TakeProfit - Take profit in pips

e FapTurbo StoplLoss - Stop Loss in pips. If Zero then itis not
used.

e FapTurbo_TrailingStop - Trailing Stop Value



FapTurbo_DurationinHours - Maximum time interval allowed
to keep the opened position. This feature closes the open
position when the time is elapsed. If Zero then not used.

FapTurbo_CloseAfterXmonths - Defines the “every month”
closure strategy. If you set Close AfterXmonths = 1 it will close all
positions on the first trading day (on first trading tick) of each
month to refresh and start new month. If you set to 2 then it will
close every 2 months etc. If you set it to Zero then it is not used.

FAPTURBO has 2 Moving Averages (slow & fast) that are used as a
global trend indicator and their possible cross defines the risky

trading zones that should be avoided. So our goal is to predict the

possible MA cross-zones and avoid trading during such dangerous

conditions.

e FapTurbo_PeriodMALarge - period of slow MA Filter (Daily)
e FapTurbo_PeriodMASmall - period of fast MA (Daily)

e FapTurbo PriceMA 0 6 - PriceMA 0 6 - the way of

calculating MA. 0=PRICE_CLOSE, 1=PRICE_OPEN,
2=PRICE_HIGH, 3=PRICE_LOW, 4=PRICE_MEDIAN,
5=PRICE_TYPICAL, 6=PRICE_WEIGHTED

FapTurbo TypeMA 0 3 - type of MA: 0 = Simple, 1 =
Exponential, 2 = Smoothed, 3 = Weighted
FapTurbo_ShiftMALarge - MA Shift in Daily bars for slow MA
FapTurbo_ShiftMASmall - MA Shift in Daily bars for fast MA
FapTurbo_LookForDays - the number of daily bars to

count back from the current bar to calculate possible MA
Cross. Used if FapTurbo_CriticalDays > 0

FapTurbo_CiriticalDays - the number of critical days after
the expected cross of MAs. If zero then it is not used. If we
expect MA Cross then FAPTURBO will miss dangerous trading
days.

FapTurbo_ RelaxDays - If zero then it is not used. The
number of days to miss after the possible MA cross.



FAPTURBO long strategy has 3 parameters for Hedging:

FapTurbo Hedging - turns on and off the hedging
feature. If Hedging is on (1) then Fapturbo will not open
(FapTurbo_MaxOrders /2) positions in one direction. This feature
prevents us from opening a lot of similar positions in one
direction. So when you activate it FAP will control and balance
the number of positions in each direction.

FapTurbo_HedgingLotReducer - Opens every new added
trade with decreased lot size. 0 — not used. For example, if
HedgingLotReducer equals 2 and first trade is opened with 1 lot
then next trade will be opened with 0.5 lot, etc.

The following parameters help Fapturbo to find the critical and
risky days and avoiding trading on critical days:

FapTurbo_TradeNFP - if Zero then Non-farm-payroll days
are avoided. NFP days often bring huge price movements that
are considered as risky and should be avoided.

FapTurbo TradeFriday - if Zero it does not trade on
Fridays. Market behavior is usually unpredictable on Fridays and
should be avoided.

FapTurbo_Prudent - If 1 (on) then Fapturbo will be very
careful and miss all risky days when slow and fast MA have
different directions

FapTurbo_SymAlligatorOnCiritica — If not zero then Fapturbo will
trade with symmetrical Alligator indicator on the risky days
when slow and fast MA have different directions

FapTurbo_FixedDirection - If on (1) then during the days
when both MA are targeted up it allows trades on BUY only. If
both MA are targeted down then allows only SELL trades. l.e.
follows the global trend strictly.

FapTurbo ClsLsrOnMrktChnge - If on (1) then it closes all
open losing trades if their direction is opposite to the MASmaill.

FapTurbo_ AlwaysTrade - If on (1) then uses safe lot size
(FapTurbo_LowLot) during dangerous days.



e FapTurbo LowLot - safe lot size for dangerous days. It is
used only if FapTurbo_AlwaysTrade is not zero

e FapTurbo TooGoodToBeTrue - maximum number of daily
bars where both MAs have the same direction. The idea of this
parameter: if the trend is very stable for a long time - that is too
good to be true. Time to expect the bad news and danger
days!

e FapTurbo PrudentPeriod - Number of days after
“FapTurbo_TooGoodToBeTrue” event that should be
considered as risky days.

Trading Intervals limits. During this interval (in broker time) Fapturbo
will look for new signals to open positions. During other times it does
not open new positions, only monitors already opened positions. If
Start and End time are the same then it works around the clock! For
example if you set StartWork TimeHour = 12, StartWork TimeMin = 20
and EndWork TimeHour = 17, EndWork TimeMin = 00 then FAPturbo
will open new trades every day only between 12-20 and 17-00.
During other time FAPturbo will only monitor old opened trades but
never open any new trades.

e FapTurbo_StartWorkTimeHour - hour to start the trading

interval

e FapTurbo_ StartWorkTimeMin - minute to start the trading
interval

e FapTurbo_EndWorkTimeHour - hour to stop the trading
interval

e FapTurbo EndWorkTimeMin - minute to close the trading
interval

e FapTurbo OneTrade - opens only one trade during the

defined Trading Interval.

e FapTurbo SpanGator - Alligator indicator parameter



FapTurbo SlipPage - Maximum price SlipPage

FapTurbo ExpertComment - Comments FapTurbo for Log

General Settings

Magic Number - This is a unique ID number for each advisor to
help the system understand which Advisor is making the trade if
you use several advisors inside one trading account.

ColorBuy - color for displaying Buy positions
ColorSell - color for displaying Sell positions
WriteLog - writes comments to Log
WriteDebuglLog - Writes comments to Journal
PrintLogOnChart - prints comments on Chaurt

KEY - The activation key for your copy of EA.



FAPTurbo Trading Proof & Examples

FAPTURBO is famous as the first real money trading

robot. We do trade real money with our system because we really
trust it.

You can verify all statements and see the results in real time on our
website

http://www.FapTurbo.com

Short Term Scalper Strategy Forward Test

Short Term strategy can work on 4 pairs: EURGBP, GBPCHF, EURCHF
and USDCAD, M15 Timeframe

Forward Test result: deposit was doubled in 2 weeks.

(High-risk lot settings were used. Not recommended for newbies. For
safe trading use lot = 0.5 for 5K deposit!)

Account: 120 Name: FapTurbo2 Currency: USD 2008 November b, 13:59
Closed Transactions:

Close Tirne Commission  Taxes  Swap

000 000 0,00
0,00
0.00
0.00
0,00
0.00
0.00
0,00
0.00
0.00
0,00
0.00
0.00
5.11.04 01: 0 0.00
0.00

eurchf 50 5076 3 n0: 0.00

) eurgbp O 0 0. 3,11,05 02: 0 0.00

3, 11.06 01: 0 0,00

eurgbp 4 3 56 39 0.00
0.00

Closed P/L: 6223.75



http://www.FapTurbo.com/

Summary:
Deposit,/Withdrawal: 5 000.00 Credit Facility: 0.00
Closed Trade P/L: b6 223.75 Floating P/L: 0.00 Margin: 0.00
Balance: 11 223.75 Equity: 11 223.75 Free Margin: 11 223.75

Details:

3
Gross Profit: 7113.10 Gross Loss: §89.35 Total Net Profit: 6 223.75

Profit Factor: 8.00 Expected Payoff: 327.57
Absolute Drawdown: 0.00 Maximal Drawdown: 889.35 {7.34%) Relative Drawdown: 7.34% (889.35)

Total Trades: 19 Short Positions {(won %o): 10 {100.00%) Long Positions {won %o): 9 {58.69%)
Profit Trades (% of total): 18 {94.74%) Loss trades (% of total): 1 {5.26%)

Largest profit trade: 1 035.00 loss trade: -589.35
Average profit trade: 395.17 loss trade: -589.35
Maximum consecutive wins ($): 18({7 113.10) consecutive losses ($): 1 {-889.35)
Maximal consecutive profit {count): 7113.10({18) consecutive loss {count): -889.35 (1)

Average consecutive wins: 18 consecutive losses: 1

We have a lot of real money trading accounts and managed
accounts of different size: from 300 USD to 50K. All of them are
traded by FapTurbo with the same great result. That proves that you
do not need a huge deposit to make it work.

Just make sure you use correct the lot size for safety trading and you
are fine!



Long Term Advanced FAP Strategy Forward Test

e Here is an example from one of our FAPTURBO trading
accounts. It generated $4,256 USD in 4 weeks on $10K deposit.
That is 42.57% profit. You can verify it on 3rd party monitoring
Onix Trade Then we stopped demo test and went live.

42.57 | 42.57
0.001 4373
S B : 246.62
e 10 000.00 - i
Re sb 0.00 it Fa 1.73
Current Balance | Equity, USD 14 256.76 | 14 256.76 Xpe "ayoff 4_;3 27

e: $14 256.76 Equity: $14 256.76

Live (Real Money) trading accounts and statements can be
found on our official website FAPTURBO.com.



FAPTurbo Backtesting on Historical Data

Backtest on history is a good way to see how the system behaved
in the past. Of course past performance can’t guarantee future
performance and that’s why we show real money forward test
not just backtest simulations. But still, with a good probability you
can see how well the system performed during the last 9 years, so
why would it not perform the same great way next year? Of
course if the end of days does not come tomorrow ©

e FapTurbo Scalper strategy can be backtested from 1999.

e Fapturbo Long Term Strategy can be backtested from 2003
because it trades only EURUSD M1 and there was no euro in
1999.

If you are not a forex expert you do not need to perform any
backtest or optimizations. Just use the default settings and set
proper lot size (and GMT offset) and you are all set!

FAPTURBO is a very complicated robot with 2 strategies and that’s
why backtest is very slow. Do not run backtest if you have a slow
PC.

History Data Download

First you should download the historical data for your backtest
calculation.

1. Open MetaTrader MT4 platform.

2. Open Options in the Tools tab in the upper menu bar.

3. Click Charts tab.

4. Change both “Max bars in history” and “Max bars in chart” to
“999999999”.
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5. Close Options window.

6. Open History Center in the Tools tab in upper menu bar.

7. Double click EURUSD M1 button.

8. Click “Download” button. (This downloads history data from
MetaQuotes)

r

History Center: EURUISD Daily )

Symbols: Diatabacze: 2456 records
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9. Do the same for other pairs you want to backtest. For example
EURCHF and EURGBP for scalper strategy.



10. When the download is complete, close History Center window.
You are now ready for Strategy Tester (backtests) and Optimization.

Please note that for M1 timeframe maximum modeling quality is 25%.
That is normal because M1 is the smallest available timeframe for
simulation in MT4. That does not mean that simulation is not
accurate.

Known Questions and Problems:

e How do | perform a backtest myself?
To perform a backtest, you should press CTR+R or View-
>Strategy Tester in main menu in Metatrader4.
Then set the expert advisor to backtest, the proper symbol, time
interval (Use date), period and click OK. When the backtest is
finished you will see the results in “Results” or “Graph” and “Report”
Tabs below.

Expert Advisor: | FAPTURBO_13, Cop 2008, FAPTURBO.com License till 1 December 2008 Expert properiies
n | Period:| M1 Symbol properties
ieframes to generate v | Optimization Open chart

Modify expert

e Strategy test does not work!
| guess you forgot to download historical data or you forgot to
activate your copy of the EA and "allow DLLs" in the global
settings of Metatrader (Tools -> Options).

¢ My Metatrader crashes when | try to backtest!
That means you are using an outdated MT4. Please update it to the
latest build.

e What is optimization and how do | do that?
Optimization represents successive passes of the same expert
advisor with different inputs on the same data. Such parameters can
be sorted out at which the expert efficiency will be maximal. The
terminal possesses some built-in means that allow automating this
process. To optimize an expert, one has to flag the option of the
same name in the "Tester" window and press the "Start" button. Do
not make optimizations if you are not a forex expert!



e My scalper strategy backtest shows totally different, bad results
than yours!

The problem is in the spread value. You can backtest ONLY if your
spread for EURGBP = 3. If you spread is higher then backtest will show
invalid results. Also mind the possible switch from summer to
wintertime in your broker. You can’t get good results when trying to
backtest with invalid GMT Offset.
Also if your broker switches his time from summer to winter time twice
a year you can’t get valid backtest results without changing GMT

offset on history! You cant use same GTM Offest for summer and
winter times!



FAQ & Troubleshooting:
GENERAL FOREX QUESTIONS
What is Forex?

The Foreign Exchange market, also referred to as the "FOREX" or
"Forex" or "Retall forex" or "FX" or "Spot FX" or just "Spot" is the

largest financial market in the world, with a volume of over $2

trilion a day. If you compare that to the $25 billion a day volume
that the New York Stock Exchange trades, you can easily see how
enormous the Foreign Exchange really is. It actually equates to more
than three times the total amount of the stocks and futures markets
combined! Forex rocks!

What Tools Do | Need to Start Trading Forex?

A computer with an Internet connection or virtual private server for
remote trading is all that is needed to begin trading currencies. We
provide full detailed instructions so no forex knowledge is needed.

What trading software do | need to run FAPTURBO and where do | get it?

FAPTURBO is designed to work with the forex trading platform
Metatrader 4, which is now offered by many of the leading forex
brokers. Metatrader 4 can be downloaded for free from most brokers’
websites, usually via a "download trading platform” link.

What is Expert advisor (EA)?

Expert Advisor is an automated robotic script written in MQ4 language
that can work in the Metatrader4 platform and make trades for you!

Can advisors work when | am away or go out?

Yes, they can work 24 hours/day for you. You don't need to monitor the
trades if you don't have enough free time. Our Robot Advisors will
monitor the trades, open orders and close positions for you when
needed. Just keep your MetaTrader on to let them work their magic!

What if my PC lost power or rebooted?

No problem here! Just run Metatrader again and turn on the expert
aduvisor. It will continue trading. If you have continuous power losses
and poor Internet connection or simply cant keep your PC online all
the time we suggest that you order VPS (Virtual Private Server) for
hosting your trading.

How do | remove expert advisor?

To remove an advisor, just right click on its name or face in the top
right part of the chart and select «Expert Advisors -> Remove». Don't



forget to close all open trades of the current advisor if you remove
it.

Should | remove or turn off the expert advisor on weekends?

No need to do that. It will sleep when the market is closed and
continue to work on Monday automatically.

Does FOREX work 24/7?
No. Only on business days. No trading on weekends.
What is Virtual Private Server (VPS)?

VPS is a special service that can host your trading on a remote server
so you no longer need to keep your PC on 24/5 for trading!

Demo or Real account?

You should always try your expert advisors on Demo account first to
check if your broker is compatible with your current expert advisor!

We don't recommend trading on Real account without testing on Demo
first!

Can | run several advisors on the same account at the same time?

That's a great idea! You can run several advisors simultaneously to
increase your profits and minimize the risks. Don't worry if it sounds
daunting — we'll give you full instructions on how to do it.

Can | run FAPTURBO with other EAs or with manual trading?

Yes, you can. The magic number feature wil help FAPTURBO to separate its
trades from other trades.

Magic number is the unique ID number of each advisor to help the

system understand which advisor is making a trade if you attach

several advisors at the same time.

Brokerage And Trading Setup
What broker should | choose?

To get the Robot EA (Expert advisor) up and running you need to trade

on the popular Metatrader 4 platform. Basically you can use any

Brokerage you like, however we arranged a special deal with the
forex-meta guys. They wil credit your real money account with up to

USD $500 in bonus money after you’ve traded for a given time (the robot
usually makes a few winning trades a day so that goal is easily

archived) PLUS they know about the EA robot setup and are willing to

assist you should any problems occur. OPEN AN ACCOUNT WITH FOREX META
NOW (http://www.forexmeta.com/forex



http://www.forexmeta.com/forex).

What is Metatrader4 and where can | download it?

Metatrader4 is a free trading platform. You can download it from your
broker website.

What are the top brokers with metatrader4?

1. FOREXMETA FXDD http://www.forexmeta.com/forex
2. INTERBANK FX (IBFX) http://interbankfx.com/

3. ALPARI CO UK http://alpari.co.uk/

4. FXCM http://www.fxcm.com/metatrader.jsp

5. FXPRO http://www.fxpro.com/

How do | Install Metatrader4?

Please watch our video tutorials in the "VIDEO TUTORIALS" section in the
member area.

How do | get my $500 USD Bonus?

The $500 bonus credit to the account is subject to the client
completing at least 40 full lot closed trades within the first 60 days

of the account approval. Bonus is provided only by ForexMeta broker,
not by FAPTURBO developers. Other brokers do not provide this signup
bonus.

Contact ForexMeta directly to claim the bonus.

| have MAC OS. Can Metatrader4 work on MAC?

Metatrader4 was created for Windows only but there are 2 ways you can
still use it on MAC OS. The first way is to setup Metatrader on Mac OS
following this short manual. The second way is to order VPS Service

that can work with MAC OS without any problem.

Getting Started With FAPTURBO

Do | have to trade myself? Is it difficult to setup?

No! All you need to do is setup the automated trading robots (expert
advisors) and let them trade on your account to bring you profits! You
will get step-by-step instructions how to setup and run them and we have
prepared a great set of Video Tutorials for you!

How do | install FAPTURBO?

Download FapTurbo Easy Install Package from the Downloads section in
the member area and Run it. It will guide you through the setup
process. Also please watch our video tutorials in "VIDEO TUTORIALS"
section in the member area.
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Can |l install FAPTURBO manually without "FapTurbo Easy Installer?

Yes. Download the FAPTURBO package ZIP file that contains
FAPTURBO.ex4 file (place it to the /experts folder in metatrader)
FAPTURBO.DLL file (place it to the /libraries folder in metatrader)
and FAPTURBO GUIDE in PDF (adobe acrobat reader)

How much money do | need to start trading?

Depending on your broker terms, you can start trading with as little

as $100. Remember that starting out with low trading capital may put
you at disadvantage because you will only be able to trade the market
in small share sizes. We recommend that you start with capital of
$1,000-5,000 USD or train on a Demo account till you are satisfied

with the performance.

Is it hard to learn and implement your trading system?

No! Most people that purchase the FAPTURBO package start trading within
minutes of installing. We provide detailed instructions and cool Video
Tutorials! Please watch our video tutorials in "VIDEO TUTORIALS"

section in the member area.

Where can | get WinZip to unzip files?

You can download free WinZip Evaluation Version
http://www.winzip.com/downwz.htm to extract the Zip archive or just
use the free WindowsXP/Vista zip service. You can also use free WinRAR
to unzip files: http://www.rarlab.com/

Where can | get the Adobe Acrobat Reader to open PDF guide?

Download Adobe Acrobat Reader on http://www.adobe.com for free.

Where is the folder of metatrader experts? | can’t find it on my PC!

The common folder of metatrader experts is:
C:\ProgramFiles\Metatrader4\Experts or C:\ProgramFiles\InterbankFX
Trader\Experts or something like that.

How do | place FAPTURBO on VPS?

First of all you should order the ForexHoster VPS service (http://forexhoster.com). Then
upload the fapturbo files from the FAPTURBO ZIP Package (can be found in member
area download section).

Read the VPS service manual/videos for more information.

FAPTURBO Activation
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How do | Activate FAPTURBO?

Please read the FAPTURBO GUIDE "activation" section. We explained it
there in detail. Also watch our video tutorial.

| don’t get the "Activation Alert" (Alarm)!

Maybe your copy is already activated or you forgot to check "allow DLL
imports" and remove "Confirm DLL function calls" in the EA settings.
Another possible reason: Today is a non-trading day (weekend or Friday,
for example). Wait 2-3 days for this alert to appear. It will appear

during only trading days.

My expert ID=0!! Help me!!

This is a common but easy to fix glitch in Metatrader4. First check
the EA settings. Turn on "Allow DLL imports" and remove "Confirm DLL
function calls" there. Also check the global parameters of the
Metatrader: Tools -> Options -> Expert Advisors. Turn on "Allow DIl
imports" and turn off "Confirm DLL function calls". Then restart
Metatrader! You must restart your Metatrader and try again! It
helps. If it happens again in the future then just restart your
metatrader.

My Metatrader crashes when | try to attach EA to the chart!

That means you are using an outdated MT4. Please update it to the latest build

My FAPTURBO License has expired. What should | do?

We update FAPTURBO every month to make sure it is always up to date to
the modern market conditions. You should download the fresh version of
fapturbo from the member area every month and install it instead of the old
version. Each version is licensed for 1 month only. All updates are

FREE to our members.

FAPTURBO Settings and Configuration

Can | adjust parameters of the FAPTURBO advisor?

Of course...you can change stop loss, take profit and several other
parameters and filters depending specifically on your needs. All of them
are described in the FAPTURBO GUIDE. Make sure you set proper
parameters such as GMT Offset.

What timeframe and currency should | choose?

FAPTURBO has 2 built-in strategies. Each strategy is designed for its
own timeframe and currency pairs. For example Long-term strategy works



only on EURUSD M1. The scalping short-term strategy works on 4 pairs:
EURGBP, GBPCHF, EURCHF & USDCAD, M15 Timeframe. Read the GUIDE for
more information.

What are the differences between FAPTURBO Short Term and Long Term Strategy?

FAPTURBO is a powerful combination of 2 strategies: Short Term

Scalping Strategy and Long Term Advanced FAP strategy. Both strategies
are built inside one FAPTURBO expert advisor and can be switched on
and off easily using UseScalperStrategy parameter in FAPTURBO

settings.

Each strategy uses its own designed timeframe and currencies so be

sure you use the strategy on proper currency pair and timeframe. You
will find full details on each strategy and its parameters in the

FAPTURBO GUIDE and Video Tutorials

Which strategy is the best one?

There is no clear answer to this question. Every strategy is a unique
system of trading, and each has its own strong and weak points. We
recommend running both systems at the same time. You know,
diversification is the key to success!

How do | switch between Strategies?

Use UseScalperStrategy Parameter. True = Scalper strategy. False =
Long Term strategy.

Can | run 2 strategies on one account?

Yes you can. Attach FAPTURBO EA to the proper charts and set proper
parameters for each strategy. Read the GUIDE and watch our video
tutorials in "VIDEO TUTORIALS" section in the member area.

: What are the most important parameters that | have to change?

In scalper strategy you should set the proper lot size and GMT OFFSET!
In long-term strategy you should set proper lot size.

And of course the KEY value with your activation key.

Please watch our video tutorials in "VIDEO TUTORIALS" section in the
member area.

How do | Set Proper Lot size?

Use lot = 0.01 for deposits less than $1000 USD. Use lot = 0.1 for deposit from $1001 to
$4999 Use lot = 0.5 for deposit from $5000 to $9999 Use lot = 1 for deposit $ 10K and
above. The numbers could vary depending on your broker rules! Please watch our
video tutorials in "VIDEO TUTORIALS" section in the member area.

What is GMT OFFSET Parameter?

GMT OFFSET is very important parameter for scalper strategy. It



defines the offset in hours between GMT and your broker time (market
watch in MT4). It should be set carefully in order to let Fapturbo

work properly. If you fail to set the GMT offset carefully you can get
unexpected losses. Please be careful! Ask your broker about their GMT
Offset if you are not sure!

Please watch our video tutorials in "VIDEO TUTORIALS" section in the
member area.

What does Magic number mean in the expert advisor??

Magic number is the unique ID number of each advisor to help the
system understand which advisor is making a trade if you attach
several advisors at the same time.

My Market Watch is frozen! How do | set GMT Offset?

Please note if your Market Watch is frozen that means that your broker
is on the weekend holiday and that broker time is not valid for GMT
offset. You should wait until your broker is on the trading day to set

the proper GMT offset value!

How do | change the parameters after | attached the EA to the chart?
Right click on the smiling face and select "Expert Advisors - >
Properties" or press F7

What is a Stealth Mode?

Stealth Mode protects you from cheating on the broker side. Using the
stealth mode the take profit and stop loss values are not displayed to the
broker. (The orders are opened with Zero stop loss and take profit)

FAPTURBO Backtest and Optimization

How do | perform a backtest on history?

If you are not a forex expert you do not need to perform any backtest
and optimizations. Just use the default settings and set proper lot

size (and GMT offset) and you are all set!

FAPTURBO is a very complicated robot with 2 strategies and that's why
backtest is very slow. Do not run backtest if you have a slow PC.

First you should download the historical data for your backtest calculation.
To perform a backtest, you should press CTR+R or View->Strategy Tester
in main menu in Metatrader4.

Then set the expert advisor to backtest, the proper symbol, time
interval (Use date), period and click OK. When backtest is finished

you will see the results in "Results" or "Graph" and "Report" Tabs.

Read the FAPTURBO GUIDE for more info.

Strategy backtest does not work!!



I guess you forgot to download historical data or your forgot to
activate your copy of the EA and "allow DLLs" in the global settings
of Metatrader (Tools -> Options)

My Metatrader crashes when | try to backtest
That means you are using an outdated MT4. Please update it to the latest build
What is optimization and how do | do that?

Optimization represents successive passes of the same expert advisor
with different inputs on the same data. Such parameters can

be sorted out at which the expert efficiency will be maximal. The terminal
possesses some built-in means that allow it to automate this process. To
optimize an expert, one has to flag the option of the same name in the
"Tester" window and press the "Start" button. Do not make

optimizations if you are not a forex expert!

My scalper strategy backtest shows totally different, bad results than yours!

The problem is in the spread value. You can backtest ONLY if your

spread for EURGBP = 3. If you spread is higher, then backtest will show

invalid results. Also mind the possible summer-winter time switch that could occur twice
a year at your broker! You cant backtest well with invalid GMT offset!

Specific FAP And FAPTURBO Questions
What is Forex Autopilot (FAP)?

Forex Autopilot (F.A.P., ForexAutoPilot.com) is a fully independent
software robot which trades the foreign exchange currency market on
autopilot 24 hours a day. Robots such as Forex Autopilot are called
"Expert Advisors" or EAs, and are attached to the currency charts in
the trading platform software which is provided by forex brokers.
ForexAutoPilot was created by Markus Leary and his team.

What is the difference between FAP and FAPTURBO?

FAPTURBO is built on the FAP (Forex Autopilot) engine but it is a whole
new generation of product. FAPTURBO developers have added great number of
new features to FAP Algorithm to make it More Safe and More Profitable.
Now FAPTURBO FAP strategy uses fixed stop loss value so your possible
losses will be small and limited. A great number of additional safe

filters and indicators were added to prevent trading in risky

conditions. Advanced filters and indicators that were added to the
system make sure FAP avoids risky periods with unstable market and
makes most of the profitable trades with high accuracy.

Plus a new short-term scalper strategy is introduced in FAPTURBO that
works on 4 pairs and showed great results in live real money trading.

What is the percent of winning trades?



According to history backtests from 1999-2008 and live trading results
FAPTURBO EA makes 96% of winning trades. You can always perform
backtest yourself to check that.

| did not like the "no stop loss idea" in FAP. How about that in FAPTURBO?

FAPTURBO FAP strategy uses fixed stop loss value so your possible
losses will be small and limited. A great number of additional safe
filters and indicators were added to prevent trading in risky
conditions.

FAPTURBO Support

Do you provide support?

We provide rapid email support and Phone support to our members. Feel
free to contact us if you have any questions or problems at support@fapturbo.com.
Please give us 24-48 hours to reply.

What is the support phone number?

You can call our technical support for more assistance and help
+1(619)202-4138

Working hours: 6am - 3pm PST (Pacific Standard Time)

Monday - Friday

Due to the overwhelming response our lines are currently extremely

busy. We are working on adding more phone support but those people need
to receive the proper training as well. Please only call when you have

serious problems that the manuals, video files and the FAQ do not

cover.

Do you provide Video Tutorials?

Sure, we have prepared a bunch of cool video tutorials for you and a
perfect step-by-step FAPTURBO GUIDE! You can find them in the member areal!

What is FAPWINNER.com?

FAPWINNER.com (FAP-WINNER.COM) is a special service for
ForexAutoPilot & FAPTURBO clients with premium support (rapid support,
Live Chat, Appointment Calendar, Forum, Phone support) and advanced
trading opportunities (Special FAP settings, Personal Trading Plan,
Hedging EA) as well as weekly Mentoring and Coaching Class and
Seminars/Webinars.

FAP-Winner was founded by Charles A. Floyd I, professional forex

trader with 20 years of experience.

FAP-Winner is not a part of FAPTURBO or FAP service, it is a separate
product created by Charles A. Floyd, 1.

Do you have a private member FORUM?
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A forum is a part of the FAPWINNER.com service. All FAPWINNER members have
access to the private discussion forum where all your questions can be
answered. You can discuss anything related to FAP and FAPTURBO including
setup, effective strategies, usage and settings.

Is FAPTURBO Legal?

FAPTURBO and FAPWINNER partners are 100% legal services. FAPWINNER,
LLC is proud to be an authenticated Limited Liability Company in good
standing with the State of lllinois. Address: 4710 Lincoln Hwy, Suite

234, Matteson, lllinois.

Problems & Troubleshooting

| can’t activate my Copy!! My expert ID=0!! Help me!

This is a common but easy to fix glitch in Metatrader4. First check
the EA settings. Turn on "Allow DLL imports" and remove "Confirm DLL
function calls" there. Also check the global parameters of the
Metatrader: Tools -> Options -> Expert Advisors. Turn on "Allow DIl
imports" and turn off "Confirm DLL function calls". Then restart
Metatrader! You must Ft
helps. If it happens again in future then just restart your

metatrader.

My Metatrader crashes when | try to run Fapturbo!!

That means you are using an outdated MT4. Please update it to the latest build.
Contact your broker if you can’t update your MT4 manually.

| installed FAPTURBO but | don’t see it in the NAVIGATOR Tab in metatrader!

The problem could be that you have several Metatraders installed on
your PC. Check if you installed FAPTURBO to correct folder of the
correct MT copy

I have the little smiley face in the right top corner, but it is not
doing anything.

If the face is smiling that means EA is working correctly. It will

open trades when it identifies the proper market situation. Have
patience. It will open new trades sooner or later (often during first
few days). Most of the advisors don't open the new orders instantly
after you run them! Advisor is monitoring the market and opens its
trades only on condition of possible profits!

| have a large draw down on my open trade. What's wrong? Am | losing money?

There is no problem here. Your trade is not closed yet. Have patience.
Drawdowns are a normal part of the Forex investing landscape and they



must be expected. FAPTURBO is not a crystal ball, it is a system that
uses various technical indicators to enter and exit trades.

FAPTURBO has a built-in Stop Loss value so even if you experience a
losing trade the loss will be limited by the Stop Loss value.

You should know that All trades stay in minus for some time. The Forex
Market always has price movements in both directions - there is no
problem here. You can backtest on the EA history to better understand
how it works. A current minus does not mean a loss, because the trade
is Open. Only closed trades can be considered losing trades. FAPTURBO
makes 96% winning trades

Why do my trades start in Minus?

Please note that all new open trades stay in minus for some time
because you have to pay the "spread"” (commission) to the broker! That
is not a problem. Sooner or later most of the trades will close in

profit. Have patience.

When | drag the expert advisor onto a chart, | don't get the smiley
face, just an X. | follow the procedure but it still doesn't respond.

The Smiling Face icon means that EA works correctly. If you don't see
the Smiling Face, just click on the "Expert Advisors" button on top of
the Metatrader menu.

| see the sad face :( of the expert advisor instead of smiley face :)

If you see the Sad Face that means you forgot to set "Allow live
trading" parameter for the expert advisor. Please check the
parameters.

Why are some expert advisors shown in grey in the NAVIGATOR TAB?

Experts-Robots are shown in grey because they don't have open source
codes. That's fine. It is not the problem at all. They will still work

fine if they have the Smiling Face on the top right of the attached

graph. Template MT4 experts like "MACD Sample" and "Moving Average"
are free samples with open source and that's why they are shown in
yellow.

| can’t activate my copy because the Activation ALARM does not appear!!
Maybe your copy is already activated or you forgot to check "allow DLL
imports" and remove "Confirm DLL function calls" in the EA settings.
Another possible reason: Today is a non-trading day (weekend or Friday,
for example). Wait 2-3 days for this alert to appear. It will appear

during only trading days.

FAPTURBO doesn't trade! What am | doing wrong??

If FAPTURBO does not open a single trade after 1 week that means



something is wrong here.

Here is what to do:

-First of all, please carefully check all the setup steps according to

the FAPTURBO GUIDE.

-Make sure you have a smiling face of FAPTURBO EA on the right top

side of the Chart.

-Check if your copy is activated.

-Check the Log or Journal for possible errors. Contact our support for help.
-Check if the FAPTURBO.DLL exists in the expert/libraries folder in

your Metatrader

| get the error "No money to open more orders."?

That means that your deposit is too small for the current level of
risk. Try to increase your deposit or decrease the lot size. For
example, change the lot size from 1 to 0.1 in EA parameters.

| get "alligator jaw error!

In most cases all Alligator jaw errors mean is a temporary connection to
broker error. You can skip them. Such errors are removed automatically
when connection is established again.

| get error "Trade is not allowed".

That could mean you logged in using the Investor password instead of
Trader password or forgot to "allow live trading" in EA settings

My orders are opened with Zero stop loss and Take profit!! Help me!

There is no problem here. You use the Stealth mode. Stealth Mode
protects you from cheating on the broker side. Using the stealth mode
the take profit and stop loss values are not displayed to broker. That
does not mean that your order does not have stop loss and take profit.
Itis "inner" and not visible.

| get "order send error".

Check the take profit and stop loss settings. Some brokers do not
allow scalping. Enable the Stealth mode.

My trading results are bad. What is wrong?
There could be a few possible reasons:

1. First of all please carefully check all the setup steps according

to the FAPTURBO GUIDE.

2. If you use the Scalper strategy check the Spread value. It should

be 3-4 for EURGBP or less for proper trading. Take into account that
some brokers increase the spread value at night and cheat you! Check
spread at night too.

3. For scalper strategy make sure you use PROPER GMT OFFSET. Failing
to set the proper GMT OFFSET will result in a loss and bad trading!

Read GUIDE for more details!



4. Please note that when trading with any forex strategy you should take into
account that your goal is to make a profit long term. You should check your results
monthly or quarterly, not every day or every week. The idea here is to

make you a profit in the long run! So have patience and you will be amazed by
how well it works!

My trading results differ from yours on site.

Trading results could differ in different brokers and even inside one
broker. That is normal.

Demo and Real accounts have different spread size and different order
execution times so results could vary too. That is not a problem.

Don’t forget to double check GMT Offset parameter!



